
Glossary of Second Life Terms (loosely based on the SL Wiki)

Agent
The data representation of the current user. In general, the code uses “agent” to mean you
and “avatar” to mean someone else. Identified by a UUID, usually called “agent_id” in the
code.

Animation
A file or in-world inventory item that moves or animates your avatar. You can use
animations to make your avatar clap their hands, dance, blow someone a kiss, and much
more.

Allowance
Another name for stipend - you get this when you own a premium account. Currently the
rate is $L 300 per week, or a little over one US dollar.

Alt (Alternate Account)
An alternate account (or "alt" for short) is an account used by a resident for something
other than their usual activity or to do things in privacy (such as building or scripting).

AO (Animation Overrider)
A scripted device that contains replacements for the default walking, sitting, flying, and
standing animations of your avatar. You need AOs to make unusual avatar shapes appear to
move naturally.

Asset
A data resource such as an image, sound, script, object, etc. Assets can be downloaded to
the viewer or uploaded into a central asset store. Assets are identified by UUID and type.

Asset Server
The database that tracks all Second Life objects in-world and in inventory. Overloaded asset
servers can cause search, inventory, rez, teleport, and Friends list failures. This is why
Linden Labs will warn you not to rez any objects or buy anything when the asset servers are
down.

Attach
To take an item from inventory and cause it to be fixed to a certain part of your avatar’s
body.

Attachment
An object (clothing, weapons, jewelry, shoes, etc) that can be attached to an avatar at a
specific location. Usually location is set by the creator of the object.

Auto-return
Auto-Return to a specified number of minutes so that the foreign objects will be returned to
the objects' owners after those minutes have expired. Land owners can also set this value
to zero (0), which will never return objects to their owners, and will remain on the parcel
until the land owner manually returns them.

Avatar
The graphical representation of a user.

Baked



Instead of trying to calculate all the layers your avatar is wearing (clothing, skin, etc), the
final appearance is baked onto your avatar to make it render faster. If you have materials
missing, sometimes people will tell you to re-bake.

Ban
Forbidding entry to a land parcel, to add someone to your ban list and thus eject them from
your land.

Banlines
Lines of floating red letters spelling out “no entry” that appear on the boundaries of a land
parcel that your Avatar is not allowed into by the owner. You can avoid ugly ban lines by
using security scripts that warn and the automatically eject avatars.

Banlist
The list of those banned from an area, by use of a script, or by Landban that otherwise
allows visitors.

Bondage
Bondage in the context of second life means restraint of an avatar by some means,
generally in the context of slsex roleplay. This can include use of scripted objects or builds,
as well as animations. Bondage is related to fetish and BDSM activities in general.

Bling
Jewelry and attachments scripted, particle based shimmering “bling” effects.

Body Part
A component of an Avatar; shape, skin, hair, eyes, and/or prim attachments are Body Parts
that combine to create an Avatar’s form. Different body parts can be created and saved to a
user’s inventory.

Bot
An avatar controlled by computer scripting rather than played by an individual. Bots can be
used for camping, land management, non player characters in role playing sims, and other
less savory activities.

BRB
Be Right Back, shorthand meant to imply that the speaker is away from the keyboard for a
moment, but will return very shortly.

BTW
By the Way.

Build
To create/make something out of primitives. Or sometimes it's used to refer to the object
was created. "That's a great build."

Busy Mode
Where your Avatar does not hear nearby chat, where IMs receive the “busy mode”
response, and all inventory and teleport offers are automatically declined.

Cage
To trap an avatar in place by rezzing trap object which surrounds them from moving.
(teleport somewhere else or log out to get loose)



Camping/campers
Some locations pay users to stay in the area with objects or Lindens. Usually the user must
sit in a specific chair (camping chairs) or click on a specific area. Camping increases the
traffic score for an area to make it appear more popular.

Camera
Viewpoint from which you see the Second Life world.

Child
Child refers to an object or agent connected to or associated with another asset. While it is
often technically part of the asset, it is not in itself the asset. Prims sub-linked to other
prims are an example of a child. An avatar standing in a sim next to the one you are in
would be a "child agent" of the sim you are standing in. Similarly, an asset attached to your
avatar would also be a child.

Client
The client is the SL program. It's what you use to log in. There are often beta clients and
other third party clients available too.

Client Lag
Client Lag is lag caused by a high load on the user side client.This can include prim clutter,
particles, large numbers of avatars or highly interactive games. The quality of your video
card will have a huge impact on this.

Collar
In second life the word collar can be used as a verb or a noun. The collar denotes slavery.
Being collared means you're captured for slavery.

Collision
Collision usually refers to the scripting calls related to collision events. A collision will occur
when an object or avatar collides with something. Colliding with other avatars on purpose in
non combat areas is frowned upon.

Continent
The large landmass usually referred to as the mainland.

Coordinate
A coordinate is a position in 3D space represented in the form of a vector (x, y, z). The
current coordinates of a resident's avatar in-world are usually visible at the top of the
screen next to the name of the parcel they are on. These coordinates are the position in the
sim ("sim-local", not "global").

Copy
Copy is a permission. Creators can set the ability to make copies of an object.

Clear Cache
Often problems with slow-loading textures or objects can be fixed by clearing your cache.
Clearing your cache can also make missing inventory items reappear.

Cyber
The act of sex within SL. Can be used as a verb or noun.

Damage
A parcel that has "Damage"/"Not Safe" enabled, which means residents can be harmed on



that parcel. If you're in a damage enabled parcel and "die," it just means that you're
teleported back to your home loation. Leaving the area will also regenerate your health.

Death
When your avatar is in an area that allows damage to occur, shown by a heart top of your
screen.

Deed
To give a parcel of land to a group, to give an object to a group. The object becomes the
property of the group.

Detach
To remove an item that has been attached to a specific part of the avatar’s body and return
it to inventory. Right click on the object and select detach.

Draw Distance
The distance you can see in the far distance - Edit > Preferences Menu

Drop
To remove an attached item from your avatar and drop it on the ground, instead of
returning it to your inventory.

Emote/emoticon
An emote is a way to express a resident's emotions/feelings via chat. :-) ^-^

Estate
A collection of regions with a particular set of rules, such as banned users, sun position, etc.
Each estate has an owner, either a user or “Governor Linden”. Most privately owned regions
are in their own estates. You can check the covenant of estates to find out their rules. You
also don't have to have a premium account to own land on an estate (unless you're the
estate owner)

Event
A group activity, led by a host, that starts and ends at specific times, and can be
legitimately listed on the Search/Events calendar.

First Land
First Land was a program Governor Linden introduced to help new residents acquire land at
reasonable prices.

First Look
These are beta test clients. Residents can often use the Second Life First Look software and
try out new features.

Flexi
Flexible. This is a setting for some prims to make them move and bend with movement,
wind, or gravity. This is commonly seen in things like flags, hair, and dresses.

Forums
Refers to the "official" forums on the Second Life website.

Freebie
An item/object made available at no cost



Freeze
A function used by landowners to bring a havoc-wreaking resident under control. Once
frozen, an avatar stops flying, falls to the ground, and is unable to move.

Full Mod/ Full Perms
An object set so it can be freely copied, modified, and transferred. Full permission.

Furry
Resident using anthropomorphic animal avatars. For some residents, furry has sexual
connotations, but not for all of them.

Floater
A dialog or window appearing in the user interface. Implemented in classes titled
“LLFloater*”

Fly
Avatars in Second Life can fly by pressing the Fly button on their screens. Some regions
disable this feature.

FMOD
Cross-platform audio library. Used to play decompressed sound effects and stream MP3
music to users on particular parcels. See FMOD.org.

Gadget
Particular form of scripted item; usually one that is a) worn by its user; and b) focuses on
providing that user with extra functions, as opposed to doing anything externally visible.
HUDs and AOs are common Gadgets.

Grid
A collection of sims. Linden Lab runs several grids for internal and external testing. Test
grid, main grid, and teen grid are the three most common grids you'll hear about in SL.

Gesture
Gestures are unique combination of sound, animation, and chat that can be preconfigured
to go off with a command or a specific phrase, (for example, you can have your avatar clap
his or her hands and play the sound of applause whenever you type: /clap).

Global
Coordinates or conditions related to the entire grid such as global coordinates

God Mode
A special mode of Second Life which only Linden staff members can access. A Linden in God
Mode is invisible to sensors, cannot be pushed or damaged, has unlimited L$ and has full
permissions access to every object on the grid. All actions that Lindens engage in while
using God Mode are logged and inspected; any use of these powers for other than testing
and legitimate administration purposes will usually lead to them getting fired.

Gorean
One of the largest SL role playing sub groups are followers of the Gor novels by John
Norman. Players are called Goreans. This group is slightly controversial outside of Gorean
role play, since the world largely treats women as property. Women are either Gorean
slaves or Gorean Free Women. Free Women wear veils and often appear to be pregnant.
Some Gorean sims are full of complicated rules and areas where anyone wandering in can
be collared, so it's a good idea to read up on the rules before visiting Gor.



Grey Goo
An object which continuously makes copies of itself. Can be produced by accident, but is
generally considered a form of Grid Attack.

Grid Address
(also Grid Coordinates) - the name of a region combined with three numbers between 0 and
255 for the X & Y (north-south & east-west) coordinates, and from 0 to 760 for the Z (up-
down) coordinate.

Grid Attack
A coordinated attempt by griefers to crash Second Life as a whole, or multiple servers
within it. Attempting a grid attack is grounds for instant and permanent banning from
Second Life.

Grid Monkey
A Linden (which varies at any given time) assigned to care for the grid and resolve
hardware and software issues. There usually is a grid-monkey on-call at all hours of the
day/night, making sure someone is ready to take care of any issues at all times.

Griefer
A person whose primary purpose is to harass others and destroy their enjoyment of Second
Life. Griefers should be Abuse Reported through the Help Menu.

Griefing
Griefing is a term which applies to activities designed to make another player's life or
experience in Second Life unpleasant.

Group
Groups vary in interest and purpose. Some are private, some are public, some cost money,
some share ownership of property.

Group Title
The labels designated for officers and members of a group. Group Titles appear over an
avatar’s name when that group is active.

Havok4
The physics engine for the Second Life that handles real-time interaction between objects or
other characters. This is the same engine that powers other online games.

Help Island
An optional post-Orientation Island new resident learning area.

Home
The location that you teleport to when you choose the menu item “Teleport Home” or when
you “die.” You can set this location with a menu command. Home may be set to land that
you own, land that a group you are a member of owns, or Linden Land that is set to allow
home to be set (such as TG Welcome Areas or InfoHubs).

Host
Any server computer, but usually a sim.

HUD
(Heads up Display) A control panel for an AO or other device that appears on screen.



IM
(Instant Message) The chat window that allows two players to speak privately, to instant
message another resident.

Infohub
A Linden Lab-owned information and social area. Infohubs are located at some of the former
Telehub locations and are built and managed by residents or resident groups. Some new
players first arrive at Infohubs after leaving Orientation Island or Help Island.

Inventory
The window that contains everything you possess that isn’t manifest in the world. Your
inventory is the collection of clothing, objects, textures, etc. that your avatar possesses.
Your inventory travels with you, and you can use any of it at any time.

In-World
Being connected to the Second Life servers and present in the Second Life world (also:
online), anything that takes place within the virtual environment of Second Life.

Island
A Sim or group of Sims that are detached from the Linden Lab owned Mainland and only
accessible by teleportation.

Issue Tracker
The JIRA public issue tracker, located at http://jira.secondlife.com, is a searchable database
used to organize issues (i.e. bugs and feature requests) submitted by the Second Life
community.

Kick
The forced log-off of a resident from Second Life by an administrator.

KK
Equivalent to “OK”

Lag
The condition of running slowly. This can be caused by the server, your internet connection,
or the objects, scripts and activities of the players around you.

LSL /Linden Scripting Language
A C-like language used for server-side scripting of objects.

Land
Land in Second Life is much the same as it is in the real world, reaching to all ends of the
world. Land is also sometimes called "ground" or "terrain". Land can be edited (or
"terraformed") in many ways: flattened, smoothed, raised, roughened, etc

Land Baron
A resident who makes profit in-world by buying and selling land, or by developing and
selling land on Private Estates.

Landmark
Landmarks are shortcuts to places in Second Life > World > Create Landmark here,
landmarks are stored in your Inventory for later viewing. You can also give and receive
landmarks from others.



Liaison
A Linden who work as front-line technical support or serve as an in-world representative.

Linden
An employee of Linden Labs. Linden employees are referred to as “Lindens” because all of
them have that last name when in the game. Linden is also used to refer to Linden Dollars.

Linden Dollar
The unit of currency for all monetary transactions in Second Life. Lindens are a
microcurrency and can be traded for real world currencies on the Lindex and on other third
party exchanges.

Linden Lab
The creators of Second Life.

Link
When building, multiple prims may be linked together with a menu command. When linked,
they can be moved as one unit.

Limits
Limits of Second Life include Building, Avatar, Chat, Groups, Inventory, Land, Performance,
Scripting and Textures.

Lock
To set the lock flag for an item, making it un-modifiable.

Log
A transcript of chat, or of computer activities.

LOL
Laughing Out Loud.

Lucky Chair
Scripted chairs that give out prizes when you sit on one that is displaying the first letter of
your first name.

Machinima
"Machinima" is a neologism based on the phrase machine cinema. The term is used to
distinguish between traditional animation techniques (which use specialized 3D animation
software) and animation projects that record the action in real-time interactive 3D
environments, such as single-player video games or Second Life.

Mainland
The largest masses of non-island linked simulators in the Second Life grid that refer to
Linden-designed continents.

Mainlanders
"Mainlanders" is a term for SL residents who live on one of the Linden owned mainland
continents. In order to own land on the mainland, you must have a premium account.

Map
The window that displays the map. It can be used to find locations, individuals, and specific
coordinates.



Message Template
The protocol description for UDP packet communication between the viewer and servers.
Described in the text file app_settings/message_template.msg.

Message of the Day
A message that shows up when you are logging into Second Life

Modify
Modify (modification) is a permission. An avatar or object can be modified in many ways.
Often just shortened to "mod."

Mouseview
(also Mouselook) Typing the letter “m” will change the main window to a first-person
camera view that will change according to mouse motions. This is the usual view for
weapons fire. It is also useful for flying in some circumstances. Hit the Escape key to exit
Mouseview.

Mute
Choosing the option that prevents you from seeing the chat from another player.

Neko
A half cat, half human avatar. Usually with cat ears and a tail.

Newbie/Noob
A newcomer to Second Life or Teen Second Life; a resident who has joined for a relatively
short period of time and/or is not familiar or comfortable with Second Life’s culture,
interface etc. The newbie cut-off point is generally considered to be at around 90 days.

No-Copy
Any object whose permissions do not permit the current owner to make additional copies of
the object. These objects have (no-copy) in their name in the inventory.

No-Fly
Any land parcel that does not permit flying. You can fly through no-fly parcels, but as soon
as you touch down and stop flying, you’ll be unable to fly again until you exit the no-fly
parcel. If you get really stuck, teleport somewhere else.

No-Modify
Any object whose permissions do not permit the current owner to make changes of the
object. These objects have (no-modify) in their name in the Inventory.

Non Physical
A method of avatar movement obtained by sitting on a non-physical prim and then moving
the prim with the edit tools, or using a script in the prim for controlled movement. A non
physical avatar can pass through walls and cannot be pushed; they are considered an
immovable object from the point of view of any physical object that strikes them.

Notecard
An inventory item containing text and/or embedded textures, snapshots, objects, or other
notecards. Items embedded in notecards must have copy/modify/transfer permissions.

No-Transfer
Any object whose permissions do not permit the current owner to resell or give away the



object. These objects have (no-transfer) in their name in the Inventory.

Occlusion
3D graphics rendering technique that ensures that the computer does not spend time
attempting to draw things that are not visible (typically because they remain hidden behind
something else).

Offline
The state of being disconnected from the Second Life servers and absent from the Second
Life world.

Off-world
Off-world is when an object or avatar is sent out of the bounds of the grid.

Officer
An officer is a resident who is a member of a group and can edit various options for that
group through the group window.

Ogg
Ogg Vorbis Open source audio compression library. Sound effects are stored as .ogg files in
the asset system.

OI
Orientation Island- The first area all users of Second Life visit when they first log into the
world.

OIP
Orientation Island Public The first OI is no longer available once you complete it.

Online
The state of being connected to the Second Life servers and present in the Second Life
world. Also: in-world.

Orbiter
Orbiters send their victims so far into the sky that it would take hours for them to fall back
down in the normal way and/or their coordinates no longer fit within the world model.
Normally, teleporting away or–in extreme cases–relogging will fix being orbited.

Parcel
An area of land owned by a single user or group. Parcels are composed of square blocks
measuring 4×4 meters, but the blocks do not have to be contiguous. Parcels have both an
integer local id and a global UUID.

Pick
A pick is a location in a resident's profile that they have chosen to display. Some residents
have used picks to display things other than locations, such as favorite snapshots. Each
resident can create up to 10 picks in their profile.

Position
Position is the location of something that can move. In Second Life, position usually refers
to a prim or avatar (but can be other things too) in a simulator and is represented in a
script as a vector.

Popular Places



Popular places is a search category which lists the the 20 parcels with the most traffic on
the previous day. It does not differentiate between bots, campers and active residents.

Prim

Abbreviation for primitive. A 3D object in the world. Each prim is represented by a set of
parameters, including position, scale, rotation, shape, cut, hollow, etc. Prims can be linked
together into link sets. They can also be attached to avatars, but this process is separate
from linking.

Profile
A profile is used to display various information about a resident in the profile window. A
profile will always contain the resident's name, "born" date, account type and partner. Other
information can be left blank by the resident.

Region
Data set for a region of the world, like “Orientation Island”. A region can be run by any
simulator process, and regions move from sim to sim as the hosts are shut down, crash,
etc.

Rez
Rez in Second Life means to create or to make an object appear. Rezzing an object/prim
can be done by dragging it from a resident's inventory or by creating a new one via the edit
window.

Resident
A user in Second Life is typically called a resident. This term is used by Linden Lab and may
be meant to give users a feeling of "belonging" and ownership of the virtual world.
"Resident" is also used throughout most of SL in place of "user".

Scripted Object
A scripted object is an object that has one or more scripts attached. Scripted objects can be
made visible as a beacon through the View Menu.

Showcase
Editorially-controlled area that highlights some of the best inworld venues and locations that
might be of interest to new and existing Residents. This is the place to go to explore and
discover some of the exciting user-created locations in Second Life."

Skin
A texture image that replaces the default skin of your avatar. Cannot (usually) be adjusted
by the appearance sliders, but looks much better than the default skin.

Sim
Server host machine, for example sim1234.agni.lindenlab.com. The SL server grid consists
of 2000+ sims. Sometimes “sim” is also used to mean simulator process or region.
Sometimes you'll run into a message that you've encountered a different version as you
cross a sim. Ignore it and move on.

Simulator
The primary SL server process. Each simulator process simulates one 256×256 meter
region. As the viewer moves through the world it is handled off from one simulator to
another. Multiple simulator processes run on each server host, currently 2 to 16.



Snapshot
A button in the UI that will open up the snapshot preview window (Ctrl-Shift-S) with a
screenshot of your current view ( ` will save the snapshot directly to your hard drive).

Slave
In Second Life a slave refers to an individual who has accepted a submissive role in a D/s
relationship that is centered around roleplaying ownership and devotion to the Master/
Mistress. Slaves are a common role in Gorean role play.

Slebrity
Slebrity is a portmanteau of SL for Second Life and celebrity. It refers to an avatar who has
become notable in second life media, though not necessarily in the wider world.

Spam
An unsolicited instant message, notecard, texture, group invite, animate request, or object
sent to multiple people. This can be sent by another player, or by an object containing a
script.

Slider
A slider is a UI element such as in the avatar appearance menu. The slide llSetTextureAnim
parameter. A collision effect when something slides over something else.

SL Exchange/SLEXCHANGE
http://www.slexchange.com/ This is a website that sells lots of SL objects.

SLURL
A SLURL is a type of weblink that launches the Second Life client and teleports you to the
location indicated via the slurl.com website.

SLT
“Second Life Time.” The time zone corresponding to the local time at the Linden Lab offices
at San Francisco. Linden Lab now refersto Pacific Daylight Time (PDT) and Pacific Standard
Time (PST), but the term SLT is commonly used in-world by residents

Skybox
Buildings located in the sky

State
An object has different states: "normal", locked, physical, temporary, phantom, and
combinations of these (except when flexible which limits object states).

Streaming Music/Video
Music and video that may be heard and viewed on a parcel. Each parcel may have one video
and one audio stream set at any one time. Streams are specified as URLs to files or
streaming servers on the Internet. With the proper permissions, an avatar can manually
specify the URL of the streaming audio and video in the Media tab of Preferences.

SL
Second Life

Statistics Bar
A window of detailed performance data that appears on the upper right corner of the user’s
screen, enabled with Ctrl-Shift-1 or View -> Statistics Bar. The data can help identify the
source of performance problems in the client or simulator.



Stipend
Stipends are a certain allowance of money paid weekly (on Tuesday) to residents in L$.
Premium accounts receive Stipends (300L$/week)etc , though some older accounts have
been grandfathered in under previous stipend programs.

Texture
A texture is an image which can be used to cover the faces of a prim as a visual
representation of the material. Textures are used for clothing, skin, buildings, and
everything else that isn't left as the default plywood texture. Textures can be found or
purchased in-world, or you can upload them for $L10 apiece.

TY
“Thank You!”

TP
Teleport to other locations "TP me!" "Need a TP?"

SLB
Second Life Birthday Also known as "Rez Day"

TOS
Terms of Service

Tiny Prim
Micro Prim

Tiny
An extremely small Avatar, usually a furry, designed to resemble an animated stuffed
animal.

Tier
The monthly land “tax” you pay to either Linden Lab (on the mainland) or to a private island
owner to own land. The more land you own, the higher your monthly Tier fees.

Terraform
To change the shape and elevation of land. Most Mainland sims are limited to ± 4 meters
terraformability. Land on Private Estates can be terraformed up to ± 100 meters.

TTYL
“Talk To You Later”

Traffic
A Linden Lab generated measure of how many avatars frequent a parcel of land and how
long they stay. Higher traffic results in a higher placement in the “Popular Places” found by
selecting Search.

UUID
Globally unique identifier, a 128-bit number represented as a 16-byte binary value or
36-byte hexadecimal string. UUIDs can be generated by any part of the system and are
guaranteed to be unique.

User Interface/ UI
A user interface (UI or GUI: graphical user interface) is how a user interfaces with (uses) a



software application.

Vehicle
A scripted object whose movement you can control. Typically, a resident will sit on/in the
vehicle and use it as a form of transportation. Vehicles include cars, airplanes, hoverboards,
boats, UFOs, and much more.

Vendor
A scripted object that designed to sell objects, clothing, or other items to residents. Many
brands of vendors are networked and operate of a central server.

Viewer
Client software, written in C++, that runs on the user’s Windows, Macintosh, or Linux
computer.

Windlight
Sky and atmospheric and lighting effects for Second Life, developed by Windward Mark
Interactive, which was purchased by Linden Lab for their technology.

Whisper Speech
(usually by objects containing scripts) that is audible only within a 10 meter radius from the
object. Compare with regular chat (20m radius), shouting (100m radius) and Region Say
(sim-wide).

Wire Frame
A mode of viewing the world by seeing only the edges that connect the vertices of objects,
avatars, and terrain. The client wire frame mode can be toggled on and off with Ctrl-Shift-R.

Welcome Area
A Linden Lab-owned and designed information and social area for new residents.

Wiki
Second Life Wiki - Information about Volunteers, Windlight, Video Tutorials, Orientation
Guides, Projects

X-Axis
The East-West axis of the in-world coordinate system.

Y-Axis
The North-South axis of the in-world coordinate system.

Z-Axis
The up-down axis of the in-world coordinate system.


